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1 Introduction

2 Matlab basics

Matlab is a high level programming language for technical computing.1 It’s

2.1 Prelimaries

basic data element is a matrix (the name Matlab therefore stands for matrix
laboratory). Since many models and solution procedures in economics are
naturally stated as a series of matrix operations, Matlab together with
programming languages of the same class is widely used in economics.
Within this course, we shall meet the programming language of Matlab and
learn how to use it, step by step. Matlab offers a huge amount of so-called
operators and functions. This manual introduces just a selection of them.
However, the Matlab Help library offers a complete overview on all existing
elements in Matlab. The software bundle also contains a so called Help desk
that is useable as an Internet page.

4

Do start the software as usual (double-click the respective icon). The Matlab
command window (some time called Matlab prompt) will be opened. For the
time being, we will work in this window only. You will, however, later on get
to know the Matlab editor/debugger as well.
As you work in the command window, Matlab remembers the commands you
enter as well as the values of any variables you create. These commands and
variables are said to reside in the Matlab workspace.
Some times it is useful to delete variables from the workspace. Just tape
» clear

and all variables defined so far are gone.
As in the example above, Matlab code is written in Courier. There is a
command after every ». If you want to compute a command, press Enter
(Return key) and the result will appear in the command window. After a
semicolon (;) at the end of a command line, Matlab will not display the
executed command:
» 2+3;
»

in contrast to
1

Comparable high level programming languages would be GAMS, GAUSS and

Mathematica. Lower level languages are Basic, Fortran, C, C++ and Java.

» 2+3
» 5
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Preceding commands can be re-displayed by pressing the up-cursor.

2.2.1 Building a matrix

When Matlab displays numerical results, it follows several rules. By default,

In order to build a matrix you have several options. One way to do it is to

Matlab displays a real number with approximately four digits to the right of

declare a matrix …

the decimal point. If the significant digits in the result are outside this range,
Matlab displays the result in scientific notation, similar to scientific
calculators. If you prefer to see numerical results up to 15 places behind the
dot, use the command

… as you would write it by hand
» A=[1 2 3
4 5 6]
A =

» format long

1
4

In order to put back the default setting type
» format short

To get the current working directory or folder displayed, type
» cd
cd directory-name sets the current directory to the one specified. cd ..

moves to the directory above the current one. The command dir provides a
list of all files in the current directory (or folder).
To interrupt a running execution, type Ctrl+C.

2
5

3
6

… by separating rows with ‘;’
» B=[4 5 6; 7 8 9]

… or element by element
»
»
»
»
»
»

C(1,1)=3;
C(1,2)=4;
C(1,3)=5;
C(2,1)=6;
C(2,2)=7;
C(2,3)=8;

You can give a matrix whatever name you want. Numbers may be included.
(Matlab is sensitive with respect to the upper and lower case.)

2.2 Declaring variables
If a variable has previously been assigned a value, the new value overrides the
In Matlab each variable is a matrix (or rectangular data array). Since a matrix
contains m rows and n columns, it is said to be of dimension m-by-n. A m-by1 or 1-by-n matrix is called a vector. A scalar, finally, is a 1-by-1 matrix.

predecessor.
Suppose you want to look at variable C. All you have to do is typing either
» C
C =
3
6

4
7

5
8
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or
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A B

In order to build E, which is given by E = 
 , you type:
C D 

» disp(C)
3
6

4
7

5
8

» E=[A B; C D]
E =
1
3
3
5

In general, when you enter » C, Matlab does the following: It checks to see if
C is a variable in the Matlab workspace; if not it checks to see if C is a builtin-function; if not it checks if an M-file named C.m exists in the current
directory; if not it checks to see if C.m exists anywhere on the Matlab search

2
4
4
6

5
8
1
4

6
9
2
5

7
10
3
6

2.2.4 Declaring a string matrix

path, by searching the path in the order in which it is specified. Finally, if
Matlab can’t find C.m anywhere on the Matlab search path either, an error

A variable in Matlab is one of two types: numeric or string. A string matrix is

message will appear in the command window.

like any other, except the elements in it are interpreted as ASCII numbers. To
create a string variable, we enclose a string of characters in apostrophes.

2.2.2 Declaring an empty matrix

Since a string variable is in fact a row vector of numbers, it is possible to

In Matlab, there is no need to declare a variable before assigning a value to it

create a list of strings by creating a matrix in which each row is a separate

– but it is recommended.

string. Note: As with all standard matrices, the rows must be of the same

» D=[]
D =

length.
» x=['ab';'cd']

[]

x =
ab
cd

2.2.3 Building a matrix out of several submatrices
You can build matrices out of several submatrices. Suppose you have
submatrices A to D.

» x = ['ab' 'cd']
x =
abcd

» A=[1 2; 3 4];
» B=[5 6 7; 8 9 10];
» C=[3 4; 5 6];
» D=[1 2 3; 4 5 6];

2.2.5 Declaring a vector
A vector is simply a 1-by-n or m-by-1 matrix.
» f=[1 2 3]

Introduction into Matlab, Version 6.0.0
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f =
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2.2.6 Declaring a scalar (or 1-by-1 matrix)
1

2

3

A scalar is given by a 1-by-1 matrix. E.g., consider the following single

Matlab creates a vector always as a row (or 1-by-n) vector. However, it is

number:

very easy to create a column (or n-by-1) vector out of it. All you have to do is

» a=2

adding a apostrophe (transposition of a matrix - compare matrix operations
further below).

2.2.7 Managing the Matlab workspace

» f=[1 2 3]'

To see what variable names are in the Matlab workspace, issue the command

f =

who:
1
2
3

» who
Your variables are:

You can declare a vector by indicating an initial value, the step and a final
value.

A

B

C

For more detailed information, use the command whos:

» g=[1:0.5:5]

» whos
Name

g =
Columns 1 through 5
1.0000

1.5000

2.0000

2.5000

Columns 6 through 9
3.5000

4.0000

3.0000

A
B
C

Size
2x3
2x3
2x3

Bytes
48
48
48

5.0000

or check the workspace window.
As shown earlier, the command
» clear

x =
3
4
5

double array
double array
double array

Grand total is 18 elements using 144 bytes
4.5000

No step means step 1.
» x=[3:5]'

Class

deletes variables from the Matlab workspace.

Introduction into Matlab, Version 6.0.0
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Suppose we just want to select columns 1 and 3, but take all the lines.

2.3 Basic manipulations of matrices

» B=A(:,[1 3])

2.3.1 Using partions of matrices

B =
1
2
3
4
5

One of the most basic operation is to extract some elements of a matrix
(called a partition of matrices). Consider
A =
1
2
3
4
5

2
3
4
5
1

3
4
5
1
2

12

4
5
1
2
3

5
1
2
3
4

3
4
5
1
2

where (:) means select all.
2.3.2 Making vectors from matrices and reverse

In paragraph 2.2.1 Building a matrix we’ve learnt, that e.g. the element a23 of

Suppose that we want to obtain the vectorialization of a matrix, that is you

Matrix A is called A(2,3) in Matlab. Let’s now isolate the central matrix

want to obtain vector B from matrix A.
A =

B =
2
3
4
5

3
4
5
1

In order to do this we type
» B=A(1:4,2:3)
B =
2
3
4
5

3
4
5
1

1
3
5

2
4
6

» B=A(:)
B =
1
3
5
2
4
6

Suppose we have a vector B. We want to obtain matrix A from B.
» A=reshape(B,3,2)

Introduction into Matlab, Version 6.0.0
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A =
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d =
1
3
5

2
4
6

4

8

12

16

20

» E=b*a
E =
6
7
8
9
10

2.4 Matrix and array operations
2.4.1 Transposition of a Matrix
C =
3
6

4
7

5
8

» C'
ans =
3
4
5

6
7
8

Note: The ans variable is created automatically when no output argument is
specified. It can be used in subsequent operations.
2.4.2 Basic matrix operators
+

-

Addition and subtraction

*

Multiplication

/

right division

^

Exponentiation

E.g., consider the vectors a and b and a scalar i:
» a=1:5;
» b=[6:10]';
» i=3;

The vector d and the matrix E are given by:
» d=a+i*a

12
14
16
18
20

18
21
24
27
30

24
28
32
36
40

30
35
40
45
50

What, if the matrices involved in the operation are of incompatible sizes? Not
surprisingly, Matlab will complain with a statement such as:
» E=a*d
??? Error using ==> *
Matrix dimensions must agree.

2.4.3 Array Operators
To indicate an array (element-by-element) operation, precede a standard
operator with a period (dot). Matlab array operations include multiplication
(.*), division (./) and exponentiation (.^). (Array addition and subtraction
are not needed and in fact are not allowed, since they would simply duplicate
the operations of matrix addition and subtraction.) Thus, the "dot product" of
x and y is
» x=[1 2 3];
» y=[4 5 6];
» x.*y
ans =
4

10

18

You may divide all the elements in one matrix by the corresponding elements
in another, producing a matrix of the same size, as in:

Introduction into Matlab, Version 6.0.0
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C = A ./ B
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Let’s consider the following matrix G. The command G<=2 finds elements of

In each case, one of the operands may be a scalar. This proves handy when

G that are less or equal 2. The resulting matrix contains elements set to logical

you wish to raise all the elements in a matrix to a power. For example:

true (1) where the relation is true, and elements set to logical false (0) where it
is not.

x =
1

2

3

» x.^2

T =

ans =
1

» G=[1 2; 3 4];
» T=G<=2

4

1
0

9

2.5 Relational and logical operators

1
0

Suppose we want to select the elements that are greater or equal to 5 in the
matrix A on page 11 and store them in vector B. We do this in two steps. First

Matlab relational operators can be used to compare two arrays of the same

we tell Matlab to create a 5-by-5 matrix which contains 1, if an element in A

size or to compare an array to a scalar. In the second case, the scalar is

is greater or equal than 5 and 0 otherwise. Second we tell Matlab to collect all

compared with all elements of the array, and the result has the same size as

the elements of A in a row vector, for which we got a logical true (1) answer

the array.

in the first step.

<

>

Less (greater) than

» B=A(A>=5)

<=

>=

Less (greater) than or equal to

B =

==

Equal to

~=

Not equal to

5
5
5
5
5

Logical operators provide a way to combine or negate relational expressions.
Matlab logical operators include:
&

AND



OR

~

NOT

Introduction into Matlab, Version 6.0.0

17

An example is:
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2.6.4 Declaring a random matrix

» T=~(G<=2)

The rand function generates arrays of random numbers whose elements are

T =

uniformly distributed in the interval (0,1).
0
1

0
1

» R=rand(5,1)
R =

2.6 Building special matrices

0.6154
0.7919
0.9218
0.7382
0.1763

2.6.1 Declaring a zero (or Null) matrix
zeros(n) returns an n-by-n matrix of zeros. An error message appears if n is

not a scalar. zeros(m,n) or zeros([m n]) returns an m-by-n matrix of
zeros. Thus,

N =

D =
0
0

normally distributed with mean 0 and variance 1.
» N=randn(2,3)

» D=zeros(2,3)

0
0

The randn function generates arrays of random numbers whose elements are

0
0

2.6.2 Declaring a ones matrix
» E=ones(2,3)

-0.4326
-1.6656

0.1253
0.2877

-1.1465
1.1909

2.7 More built-in functions
The type of commands used to build special matrices are called built-in

E =

functions. There are a large number of built-in functions in Matlab. Apart
1
1

1
1

1
1

2.6.3 Declaring a identity matrix

from those mentioned above, the following are particularly useful:
2.7.1 Display text or array

» F=eye(3)

disp(X) displays an array, without printing the array name. If X contains a

F =

text string, the string is displayed.
1
0
0

0
1
0

0
0
1

» disp('

Corn
Corn

Oats
Oats

Hay')
Hay

Introduction into Matlab, Version 6.0.0
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2.7.2 Sorting a matrix

2.7.4 Sum of elements of a matrix

sort(A) sorts the elements in ascending order. If A is a matrix, sort(X)

If A is a vector, sum(A) returns the sum of the elements. If A is a matrix,

treats the columns of A as vectors, returning sorted columns. E.g.:

sum(A) treats the columns of A as vectors, returning a row vector of the sums

» A=[1 2; 3 5; 4 3]
A =

of each column.
» B=sum(A)

1
3
4

2
5
3

» sort(A)

B =
8

10

If A is a vector, cumsum(A) returns a vector containing the cumulative sum

ans =

of the elements of A. If A is a matrix, cumsum(A) returns a matrix the same
1
3
4

2
3
5

2.7.3 Sizes of each dimension of an array

size as A containing the cumulative sums for each column of A.
» B=cumsum(A)
B =
1
4
8

size(A) returns the sizes of each dimension of matrix A in a vector. [m,n]

2
7
10

= size(A) returns the size of matrix A in variables m and n (recall: in

Matlab arrays are defined as m-by-n matrices). length(A) returns the size of
the longest dimension of A. E.g.:

2.7.5 Smallest (largest) elements of an array
If A is a matrix, min(A) treats the columns of A as vectors, returning a row

» [m,n]=size(A)

vector containing the minimum element from each column. If A is a vector,

m =

min(A) returns the smallest element in A. max(A)
3

n =

maximum elements.
» min(A)

2
» length(A)
ans =
3

ans =
1

2

returns

the

Introduction into Matlab, Version 6.0.0
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2.7.6 Descriptive statistics of matrices
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Ax = b. One way to solve this is with x = inv(A)*b. A better way, from

mean(X) returns the mean values of the elements along the columns of an

array. std(X) returns the standard deviation using
1

2
 1 n
2
std = 
( xi − x ) 
∑
 n − 1 i =1


where n is the number of elements in the sample.
For matrices where each row is an observation and each column a variable,

both an execution time and numerical accuracy standpoint, is to use the
matrix division operator x = A\b.
2.7.9 Eigenvectors and eigenvalues of a matrix
The n-by-n (quadratic) matrix A can often be decomposed into the form
A = PDP −1 , where D is the matrix of eigenvalues and P is the matrix of

eigenvectors. Consider
A =

cov(x) is the covariance matrix. Likewise, corrcoef(X) returns a matrix

0.9500
0.2500

of correlation coefficients calculated from an input matrix whose rows are
observations and whose columns are variables.

0.0500
0.7000

» [P,D]=eig(A)
P =

2.7.7 Determinant of a matrix
det(A) returns the determinant of the square matrix A.
» A=[4 2; 1 3];
» B=det(A)
B =

0.7604
0.6495

-0.1684
0.9857

0.9927
0

0
0.6573

D =

Probably you are just interested in the eigenvalues.

10

2.7.8 Inverse of a matrix
inv(A) returns the inverse of the square matrix A.
» C=inv(A)
C =
0.3000
-0.1000

22

-0.2000
0.4000

In practice, it is seldom necessary to form the explicit inverse of a matrix. A
frequent misuse of inv arises when solving the system of linear equations

» eig(A)
ans =
0.9927
0.6573

2.8 Getting Help
Typing help topic displays help about that topic if it exists, e.g.
» help det

Introduction into Matlab, Version 6.0.0
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shows information about the use of the determinant function. Another way is
to consult the help desk in the Help Menu.
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3 Graphics

Matlab can produce both planar plots and 3-D plots. The first important
instruction is the clf instruction that clears the graphic screen.
3.1 Histogram
The instruction hist(x) draws a 10-bin histogram for the data in vector x.
hist(x,c), where c is a vector, draws a histogram using the bins specified

in c. Here is an example:
» c=-2.9:0.2:2.9;
» x=randn(5000,1);
» hist(x,c) ;

3.2 Plotting series versus their index
2-D graphs essentially rely on the instruction plot. plot(y) plots the data
in vector y versus its index, i.e.,
» y=rand(100,1);
» clf;
» plot(y)

produces the following graph:

Introduction into Matlab, Version 6.0.0
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plot(x,[a b],S) and plot(x,a,S,x,b,S), where a and b are vectors,

are alternative ways to create exactly the same scatterplot.
The S string is optional and is made of the following (and more) characters:

Line style:
Solid
-

Symbol

Dashed
--

Dotted line
:

Dash-dot line
-.

Colour:
Symbol

Yellow

Red

Green

Blue

Cyan

Magenta

White

Black

Y

r

g

b

C

M

w

k

Marker specifier:
Point
.

Symbol
plot([y x]) plots the two column vectors of the matrix [y x] versus their

index (within the same graph).
3.3 Scatterplots (2-D plots)
The general form of the plot instruction is
plot(x,y,S)

where x and y are vectors or matrices and S is a one, two or three character
string specifying color, marker symbol, or line syle. plot(x,y,S) plots y
against x,if y and x are vectors. If y and x are matrices, the columns of y are
plotted versus the columns of x in the same graph. If only y or x is a matrix,
the vector is plotted versus the rows or columns of the matrix. Note that

Circle
O

Thus,
» plot(X,Y,’b*’)

plots a blue asterisk at each point of the data set.
Here is an example:
»
»
»
»

x=pi*(-1:.01:1);
y=sin(x);
clf;
plot(x,y,’b-’);

Asterisk
*

Cross
x

Introduction into Matlab, Version 6.0.0
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3.4 Adding titles, labels and grids

3.5 Creating subplots

You can add titles and labels to your plot, using instructions :

You can also have many graphs on the screen using instruction

» title(’atitle’)
» xlabel(’alabel’)
» ylabel(’alabel’)

% Obvious
% Label on the x axis
% Label on the y axis

You can even add a grid on your plot, using grid. Here is an example:
»
»
»
»
»
»
»
»
»

x=pi*(-3:.01:3);
y1=sin(x);
y2=cos(x);
clf;
plot(x,y1,’y’,x,y2,’r–’);
title(’A nice example ?’);
ylabel(’The functions’);
xlabel(’The values’);
grid;

subplot(rcn) where r, c, and n denotes respectively the number of rows,

columns and the number of the graph:
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»
»

x=[-3:.01:3];
y1=exp(-0.5*x.^2)/sqrt(2*pi);
y2=sin(x);
y3=cos(x);
y4=abs(sqrt(x));
clf;
subplot(221);
%figure 1 out
plot(x,y1);
ylabel(’Y1’);
xlabel(’X’);
title(’Gaussian’);
subplot(222);
%figure 2 out
plot(x,y2);
ylabel(’Y2’);
xlabel(’X’);
title(’Sin(X)’);
subplot(223);
%figure 3 out
plot(x,y3);
ylabel(’Y3’);
xlabel(’X’);
title(’Cos(X)’);
subplot(224);
%figure 4 out
plot(x,y4);
ylabel(’Y4’);
xlabel(’X’);
title(’Abs(Sqrt(X))’);

of 4

of 4

of 4

of 4
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by joining adjacent points with straight lines. The result looks like a fishing
net with the knots at the data points. Mesh plots are very useful for visualizing
large matrices or for plotting functions of two variables.
The first step in generating the mesh plot of a function of two variables,
z = f(x,y) , is to generate X and Y matrices consisting of repeated rows and
columns, respectively, over some range of the variables x and y. Matlab
provides the function meshgrid for this purpose. [X,Y]=meshgrid(x,y)
creates a matrix X whose rows are copies of the vector x, and a matrix Y
whose columns are copies of the vector y. This pair of matrices may then be
used to evaluate functions of the two variables using Matlab’s array
mathematics features. Here is an example:

3.6 3-D plots

»
»
»
»
»
»

x=[-7.5:.5:7.5];
y=x;
[X,Y]=meshgrid(x,y);
R=sqrt(X.^2+Y.^2)+eps;
Z=sin(R)./R;;
mesh(X,Y,Z);

The plot command from the two-dimensional world can be extended into
three dimensions with plot3. The format is the same as the two-dimensional

3.7 Save graphs

plot, except the data are in triples rather than in pairs. The generalized

To save the resulting graph in a file just use the instruction print. Its general

format of plot3 is plot3(x1,y1,z1,S1,x2,y2,z2,S2,…), where xn, yn,

syntax is given by :

and zn are vectors or matrices, and Sn are optional character strings specifying
color, marker symbol, or line syle. Here is an example:
» t=linspace(0,10*pi);
» plot3(sin(t),cos(t),t,’b*’);
» xlabel(‘sin(t)’),zlabel(‘t’);

Next we consider mesh plots. Matlab defines a mesh surface by the zcoordinates of points above a rectangular grid in the x-y plane. It forms a plot

print -options name_of_file

To save the graph in a jpg-format you type:
print -djpeg graph.jpg

To save the graph in a ps-format you type:
print -dps graph.eps

Introduction into Matlab, Version 6.0.0
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4 Scripts and functions
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simply type example in the Matlab command window (provided there is a
file example.m in your working directory or path2).
» example

Up to now, we were content to input individual commands in the Matlab

C =

command window. For more complex functions or frequently needed
sequences of instructions this is, however, extremely unsatisfying. Matlab
offers us two possibilities of processing or of automating such sequences
more comfortably, script M-files and function M-files.
4.1 Script M-files

4

6

The use of scripts is particularly handy when you are coding problems that
consists of a large number of connected and complex indexing steps. Scripts
can operate on existing data in the workspace, or they can create new data on
which to operate. Although scripts do not return output arguments, any
variables that they create remain in the workspace, to be used in subsequent

Matlab allows you to place Matlab commands in a simple text file, and then

computations. Moreover, scripts can produce graphical output using functions

tell Matlab to open the file and evaluate commands exactly as it would if you

like plot.

had typed them in the Matlab command window. These files are called script
M-files. The term “script” symbolizes the fact that Matlab simply reads from
“script” found in the file. The term “M-file” recognizes the fact that script
filenames must end with the extension .m. Further, the name of a M-file has
to begin with an alphabetical letter

4.2 Function M-files
A function M-file is similar to a script file in that it is a text file having a .m
extension. As with script M-files, function M-files are created with a text
editor. A function M-file is different from a script file in that a function

To create a script M-file, choose New from the File menu and select M-file

communicates with the Matlab workspace only through their variables passed

(alternatively you just type edit in the Matlab prompt and press Enter). This

to it and though the output variables it created. Intermediate variables within

procedure brings up a text editor window, the Matlab editor/debugger. Let’s

the function do not appear in, or interact with, the Matlab workspace.

type the following sequence of statements in the editor window:

Functions operate on variables within their own workspace, separate from the

A=[1 2];
B=[3 4];
C=A+B

workspace you access at the Matlab command window. If we call a function
2

Do modify the default adjustments over File/Set Path/Path or by pressing the button

This file can be saved as the M-file example.m on your disk by choosing Save

“Path Browser” in the command window toolbar. A third way would be to use DOS-

from the File menu. Matlab executes the commands in example.m when you

commands:

» dir

directory; »

cd ..

lists the files in the current directory;

» cd

changes to the directory above the current one.

prints out the current
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within a code, Matlab will search the work directory for the name of the

Next, there is a sequence of comment lines with the text displayed in response

invoked M-file, minus its extension.

to the help command:

We have encountered examples of function M-files in paragraph 2, already.

» help <name of function>.

Some built-in functions, like » ones, are part of the Matlab core. Although

Finally the remainder of the M-file contains Matlab commands that create the

they are very efficient, the computational details are not readily accessible.

output variables.

Others, like » std, are implemented in M-files. You can see the code and
even modify it if you want.3 Apart from the function M-files incorporated in
the Matlab package, you can write functions on your own, download them
from other user’s homepages on the internet or buy them separately in so
called toolboxes.
4.2.1 Defining your own function M-files
We add new functions to Matlab's vocabulary by expressing them in terms of
existing commands and functions. The general syntax for defining a function
is
Function[output1,..]=<name of function>(input1,..);
% include here the text of your online help!
statements;

Let’s consider an example: We would like to build a function, that gives us
the mean and the standard deviation of a vector. (Suppose we don’t know that
there is an respective built-in function.)
function [mx,stx]=stat(x);
%
% function [mx,stx]=stat(x)
% Computes the mean and standard deviation of a
% vector x
% x:
a vector (column or row)
% mx: mean of vector
% stx: standard deviation of vector
%
lx=length(x);
mx=sum(x)/lx;
stx=(sum((x-mx).^2)/(lx-1))^(1/2);

The name of the function is stat. The input vector is called x. Output

The first line of a function M-file defines the M-file as a function and

consists of two respective variables, mx and stx. After every line that starts

specifies its name (its file name without the .m extension). The name of the

with a % there is your text of the online help. What follows next are some

M-file and the one of the function should be the same. It also defines its input

familiar Matlab statements. First we define the scalar lx as the length of the

and output variables.

input vector. Then we define the scalars mx and stx.
You now want to include and use your new function. For this purpose you
change to the command window. Suppose, your input is a 1-by-100 random

3

In order to check out whether a built-in function is an M-file or not, you can use your

Windows Explorer Tools/Find/Files or Folders and look for the respective name of the
function plus its extension, e.g. std.m. If it is indeed an M-file you can open it.

vector.
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» x=randn(1,100);
» [mx,stx]=stat(x)
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5 Controlling the flow

mx =
0.0407
stx =
0.8797

You get the variables mx and stx as an output.
4.2.2 Downloading and using function M-files from the internet
Instead of writing a function on your own, you can download required M-files
(e.g., an algorithm or an estimation procedure etc.) from the internet. You will
probably find it convenient to create your own library of tools that you will
use often.
4.2.3 Toolboxes

The structure of the sequences of instructions used so far was rather
straightforward; commands were executed one after the other, running from
top to bottom. Like any computer programming language and programmable
calculators Matlab offers, however, features that allow you to control the flow
of command execution. If you have used these features before, this section
will be familiar to you. On the other hand, if controlling the flow is new to
you, this material may seem complicated at first; if this is so, take it slow.
Controlling the flow is extremely powerful, since it lets past computations
influence future operations. With the three following sets of instruction it is
possible to cope with almost all the problems we shall encounter in
computation. Because they often encompass numerous Matlab commands,
they frequently appear in M-files, rather than being typed directly at the

Finally, function M-files can be part of a so-called toolbox. A toolbox is a

Matlab command window.

collection of function M-files that extend the capability of Matlab. In addition
to the toolboxes installed by default4 toolboxes to specific topics (like

5.1 The FOR-loop

statistics or optimization) can be bought separately. For an overview visit
http://www.cx.unibe.ch/matlab/fulldocset.html.

The most common use of a FOR-loop arises when a set of statements is to be
repeated a fixed number of times n. The general form of a FOR-loop is:
For variable = expression;
statements;
end;

The variable expression is thereby a row vector of the length n, that is
processed element-by-element (in many cases it is the row vector (1:n)).
4

In your Matlab folder you will find a folder called toolbox. By default it contains three

toolboxes: local, matlab and tour.

Statements stands for a sequence of statements to the program. The
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columns of the expression are stored one at a time in the variable while the

This example shows one way of computing the special Matlab value eps,

following statements, up to the end, are executed. The individual instructions

which is the smallest number that can be added to 1 such that the result is

are generally separated by semicolons, in order to avoid a constant output

greater than 1 using finite precision. (We use uppercase EPS so that the

from section results in the command window.

Matlab value eps is not overwritten.) In this example, EPS starts at 1. As long

A simple example of such a loop is:
for i=1:10;
x(i)=i;
end;
disp(x')

5.2 The WHILE-loop
In contrast to the FOR-loop, with which the loop will pass through a fixed
number n, WHILE-loops are executed, until an abort condition is fulfilled.
Note: You have to care that the abort condition is achieved by the program in
finite time in each case, in order to avoid a continuous loop.
The general syntax for WHILE loop is the following:
while condition;
statements;
end;

So while the condition is satisfied, the statements will be executed.
Consider the following example:
eps = 1;
while (1+eps) > 1
eps = eps/2;
end;
eps = eps*2

as (1+EPS)>1 is True (nonzero), the commands inside the WHILE loop are
evaluated. Since EPS is continually divided in two, EPS eventually gets so
small that adding EPS to 1 is no longer greater than 1. (Recall that this
happens because a computer uses a fixed number of digits to represent
numbers. Matlab uses 16 digits, so you would expect EPS to be near 10-16.) At
this point, (1+EPS)>1 is False (zero) and the WHILE loop terminates.
Finally, EPS is multiplied by 2 because the last division by 2 made it too
small by a factor of two.
5.3 The IF-statement
A third possibility of controlling the flow in Matlab is called the IF-statement.
The IF-statement executes a set of instructions if a condition is satisfied. The
general form is
if condition 1;
% commands if
statements 1;
elseif condition
% commands if
statement 2;
else;
% commands if
statements 3;
end;

condition 1 is TRUE
2;
condition 2 is TRUE

condition 1 and 2 are both FALSE
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The last set of commands is executed if both condition 1 and 2 are false (i.e.,
not true). When you have just two conditions you skip the elseif condition
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6 Importing and exporting data

and immediately go to else. An example should make the point clearer.
Assume you have a demand function of the kind
 0

D(P ) = 1 − 0.5P
 2 P −2


if p ≤ 2
if 2 < p ≤ 3
otherwise

The code will be:
P=input('enter a price :');
if P<=2;
D=0;
elseif (P>2)&(P<=3);
D=1-0.5*P;
else;
D=2*P^(-2);
end;
disp(D);

With Matlab you can do both, export your data or calculated results and
import external data.
6.1 The diary command
The diary command creates a log of keyboard input and the resulting output

% displays the message
% '.' on the screen and
% waits for an answer
% statement 1
% statement 2
% otherwise
% statement 3

(except it does not include graphics). The log is saved as an ASCII text file in
the current directory or folder. For instance let’s type the following
statements:
» diary result.out;
» disp(A);
» diary off;

In our directory appears a file named “result” with the extension .out. We can
open it in any editor. It contains the (string or numeric) matrix A.

5.4 How to break a FOR or WHILE-loop
Note: The instruction diary does not overwrite an existing file. We have to
break terminates the execution of a for FOR- or WHILE-loop.

delete it first with delete <afile> if we do not want to add information on
the existing file but overwrite it.
6.2 Save workspace variables on disk
The Save workspace as… menu item in the File menu opens a standard file
dialog box for saving all current variables. Saving variables does not delete
them from the Matlab workspace. Besides, Matlab provides the command
save.
» save
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stores the workspace in Matlab binary format in the file matlab.mat.
» save data

saves the workspace in Matlab binary format in the file data.mat.
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angular brackets and then type paste. Finally we close the brackets. We end
up with a matrix called data containing our data.
6.4 Request user input

» save capital capital

saves the variable capital in Matlab binary format in the file capital.mat.
» save capital capital –ascii

saves the variable capital in 8-digit ASCII text format in the file capital.txt.
ASCII-formatted files may be edited using any common text editor.
6.3 Retrieving data and results
The load command uses the same syntax, with the obvious difference of
loading variables into the Matlab workspace.
For example assume the data file, data.txt, takes the form:
.....1.0000 ->.....2.0000¶
.....3.0000 ->.....4.0000¶
.....5.0000 ->.....6.0000¶

We make sure that data.txt is in the right directory and then type
load data.txt –ascii;

Our data are stored in a matrix called data that we will manipulate as any
other matrix.
If our data is stored in an Excel spreadsheet then there is an even lazier way to
import data. We highlight the data to be imported in the Excel spreadsheet,
type copy, swap to the Matlab prompt, define a matrix (e.g. data=), open the

If we want the user to input information from the keyboard we use the
statement input:
n=input(‘Give a number’);

displays the message “Give a number” on the screen and wait for an answer.
The result will be evaluated in the variable n.

Introduction into Matlab, Version 6.0.0

7 References

Einführung in Matlab
http://www.stat.uni-muenchen.de/~boehme/matlab-kurs/lecture1.html
Noisser, Robert (1998): Matlab Einführung
http://www.iert.tuwien.ac.at/support/matlab_1.htm
Sigmon, Kermit (1992), Matlab Primer 2nd edition, Department of
Mathematics, University of Florida.
The Student Edition of MATLAB, Version 5, User’s Guide (1997)

43

